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WELCOME

1 October 1998

This CD-ROM contains the electronic versions of the Leg 174A, 
174AX, and 174B Initial Reports volumes. This volume is accessible 
with Adobe Acrobat software. The Acrobat PDF format is used for text, 

tables, and images.

Also included are additional tables in ASCII format that are not included 
in the printed volume. For a complete list of these files, refer to the 
section of this readme file titled “Contents of the CD-ROM.” ASCII 
files are designated by a .TXT extension; PDF files by a .PDF extension. 
Smear-slide data tables, thin sections, and shore-based processed logs 
appear only on CD-ROM.

This volume is designed to be read with Acrobat 3 or higher. Copies of 
Acrobat 3 are supplied on this CD in all major software platforms (PC, 
Mac, UNIX, and more), or are available for no charge from the Adobe 
Acrobat WWW site.

http://www.adobe.com/

http://www.adobe.com/


Also published on this CD-ROM in the Acrobat format is the Compiled 
Electronic Index of the Proceedings of the Ocean Drilling Program.

ODP’s WWW site

For more information about the Ocean Drilling Program, see ODP’s site 
on the World Wide Web at the following address:

http://www-odp.tamu.edu/

For information about accessing Acrobat from a Web browser, see the 
section of this readme file titled “How to set up a web browser.”

http://www-odp.tamu.edu/
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OPTIMAL SYSTEM FOR VIEWING

The optimal system for viewing a volume on CD-ROM would include: 
a large monitor (17 in or bigger), 
a video card with 4 MB of VRAM to support high-resolution images 
and 24-bit color, 
a quad-speed CD drive, and 
the system should be a Pentium-based PC or a Power Mac.

Acrobat Reader updates

The electronic book is presented in Adobe Acrobat. Copies of Acrobat 
Reader 3 for Macintosh, Windows, DOS, and some available UNIX 
platforms are included on this CD-ROM. Software updates may be 
found on Adobe’s WWW site:

http://www.adobe.com/

http://www.adobe.com/


IMAGES ON THE CD-ROM

With the exception of whole-core photographs, all figures appear as part 
of the page as in the printed volume. 

Notes on the Cores section photographs
In the Cores section (Section 3 for Legs 174A and 174B), the blue figure 
box links to the core photo. The viewer must click on the figure box to 
see the PDF file containing the photo. 

On this CD-ROM, images are reduced to 300 dpi. These are large files, 
and are presented in color. Without an optimal system, they will be slow 
to open. The average image file size is 400 KB.

The original images were scanned at 1200 dpi with no compression; 
hence, the average full-core image file is more than 50 MB in size. 
These images are available from ODP in TIF format. Contact:

Data Librarian, Ocean Drilling Program, Texas A&M 
University, College Station, TX 77845, U.S.A.

database@odp.tamu.edu

mailto:database@odp.tamu.edu


Scanning and calibration

Color is affected by the translation into Acrobat format. All files are 
slightly darker than the originals.

Monitors need to be calibrated to a standard available with most graphic 
software applications. An 18% gray card is included on every core 
image for calibration.



CONTENTS OF THE CD-ROM
174A Initial Reports

174AIR.PDF is the table of contents that is linked to individual files. 
Click on the chapter title to open that file. 174AIR.PDF is located in the 
root directory.

The individual files for the Leg 174A Initial Reports volume are in the 

174A_IR directory of the CD-ROM.

PRELIM.PDF contains the title page, as well as other information from 
the front of the volume, including shipboard participants and member 
nations of the Ocean Drilling Program.

The chapter files are listed by numerical order. Each file is named 
CHAP__##.PDF, where ## is the number of the chapter. The chapters 
can be reviewed as a group from 174AIR.PDF.

Also included on the CD-ROM are the following types of files:

Visual core-description (VCD) forms and digital core images in a 
PDF format. These files can be found in the 174A_IR\CORES 
directory.



Smear-slide data tables in both PDF and ASCII versions. These files 
are organized by site number. They are located in the 
174A_IR\S_SLIDES directory.

Thin-section data tables in both PDF and ASCII versions. These files 
are organized by site number. They are located in the 
174A_IR\T_SECTNS directory.

Shore-based processed logs in a PDF format. This file is 

174A_IR\LOGGING.PDF.

ASCII versions of selected tables from Chapters 3, 4, and 5. These 
files are in the 174A_IR\TABLES directory (see below for list of 
files).

List of TABLES files:

CHAP_03 (Chapter 3, Site 1071):

03_01.TXT: Table 1. Expanded Site 1071 coring summary.

03_04.TXT: Table 4. Continuous remanent measurements of 
archive-half sections for Hole 1071A before demagnetization 
(NRM). 



03_05.TXT: Table 5. Continuous remanent measurements of 
archive-half sections for Hole 1071A after 10-mT demagnetization.

03_06.TXT: Table 6. Continuous remanent measurements of 
archive-half sections for Hole 1071A after 20-mT demagnetization.

03_07.TXT: Table 7. Continuous remanent measurements of 
archive-half sections for Hole 1071A after 30-mT demagnetization.
03_08.TXT: Table 8. Continuous remanent measurements of 
archive-half sections for Hole 1071A after 40-mT demagnetization.

03_09.TXT: Table 9. Continuous remanent measurements of 
archive-half sections for Hole 1071B before demagnetization 
(NRM). 

03_10.TXT: Table 10. Continuous remanent measurements of 
archive-half sections for Hole 1071B after 10-mT demagnetization.

03_11.TXT: Table 11. Continuous remanent measurements of 
archive-half sections for Hole 1071B after 20-mT demagnetization.

03_12.TXT: Table 12. Continuous remanent measurements of 
archive-half sections for Hole 1071B after 30-mT demagnetization.



03_13.TXT: Table 13. Continuous remanent measurements of 
archive-half sections for Hole 1071C before demagnetization 
(NRM).

03_14.TXT: Table 14. Continuous remanent measurements of 
archive-half sections for Hole 1071C after 10-mT demagnetization.
03_15.TXT: Table 15. Continuous remanent measurements of 
archive-half sections for Hole 1071C after 20-mT demagnetization.

03_16.TXT: Table 16. Continuous remanent measurements of 
archive-half sections for Hole 1071C after 30-mT demagnetization.

03_17.TXT: Table 17. Continuous remanent measurements of 
archive-half sections for Hole 1071D before demagnetization 
(NRM).

03_18.TXT: Table 18. Continuous remanent measurements of 
archive-half sections for Hole 1071D after 10-mT demagnetization.

03_19.TXT: Table 19. Continuous remanent measurements of 
archive-half sections for Hole 1071D after 20-mT demagnetization.



03_20.TXT: Table 20. Continuous remanent measurements of 
archive-half sections for Hole 1071F before demagnetization 
(NRM).

03_21.TXT: Table 21. Continuous remanent measurements of 
archive-half sections for Hole 1071F after 10-mT demagnetization.

03_22.TXT: Table 22. Continuous remanent measurements of 
archive-half sections for Hole 1071F after 20-mT demagnetization.
03_23.TXT: Table 23. Progressive AF demagnetization results for 
discrete-cube samples from Site 1071.

03_29.TXT: Table 29. GRAPE density (MST), Holes 1071A–1071F.

03_30.TXT: Table 30. Index properties, Holes 1071A–1071F.

03_31.TXT: Table 31. Magnetic susceptibility (MST), Holes 
1071A–1071F.

03_32.TXT: Table 32. Natural gamma radiation (MST), Holes 
1071A–1071F.

03_33.TXT: Table 33. Thermal conductivity, Holes 1071A–1071F.

03_34.TXT: Table 34. P-wave logger (PWL) velocity, Hole 1071A.



–

 

), 
03_35.TXT: Table 35. PWS1 (z-direction) velocity, Holes 1071A
1071C.

03_36.TXT: Table 36. PWS3 frame (x-direction) velocity, Holes
1071A–1071F.

03_37.TXT: Table 37. Undrained shear strength (AVS), Holes 
1071A–1071D.

03_38.TXT: Table 38. Undrained shear strength (penetrometer

Holes 1071C and 1071F.

03_39.TXT: Table 39. Longitudinal (z-direction) resistivity, Holes 
1071A–1071F.

CHAP_04 (Chapter 4, Site 1072):

04_01.TXT: Table 1. Expanded Site 1072 coring summary.

04_04.TXT: Table 4. Continuous remanent measurements of 
archive-half sections for Hole 1072A before demagnetization 
(NRM).

04_05.TXT: Table 5. Continuous remanent measurements of 
archive-half sections for Hole 1072A after 10-MT demagnetization.



04_06.TXT: Table 6. Continuous remanent measurements of 
archive-half sections for Hole 1072A after 20-mT demagnetization. 

04_07.TXT: Table 7. Progressive AF demagnetization results for 
discrete-cube samples from Hole 1072A.

04_13.TXT: Table 13. GRAPE density (MST).

04_14.TXT: Table 14. Index properties.
04_15.TXT: Table 15. Magnetic susceptibility (MST).

04_16.TXT: Table 16. Natural gamma radiation (MST).

04_17.TXT: Table 17. Thermal conductivity.

04_18.TXT: Table 18. Velocity (PWS3 frame, X-direction).

04_19.TXT: Table 19. Undrained shear strength (AVS).

04_20.TXT: Table 20. Undrained shear strength (penetrometer).

04_21.TXT: Table 21. Longitudinal (Z-direction) resistivity.

CHAP_05 (Chapter 5, Site 1073):

05_01.TXT: Table 1. Expanded Site 1073 coring summary.



05_05.TXT: Table 5. Continuous remanent measurements of APC 
archive-half sections for Hole 1073A before demagnetization 
(NRM).

05_06.TXT: Table 6. Continuous remanent measurements of APC 
archive-half sections for Hole 1073A after 10-mT demagnetization.
05_07.TXT: Table 7. Continuous remanent measurements of APC 
archive-half sections for Hole 1073A after 20-mT demagnetization. 

05_08.TXT: Table 8. Continuous remanent measurements of XCB 
archive-half sections for Hole 1073A before demagnetization 
(NRM).

05_09.TXT: Table 9. Continuous remanent measurements of XCB 
archive-half sections for Hole 1073A after 20-mT demagnetization.

05_10.TXT: Table 10. Progressive AF demagnetization results for 
discrete-cube samples from Hole 1073A.

05_17.TXT: Table 17. GRAPE density (MST).

05_18.TXT: Table 18. Index properties.



05_19.TXT: Table 19. Magnetic susceptibility (MST).

05_20.TXT: Table 20. Natural gamma radiation (MST).

05_21.TXT: Table 21. Thermal conductivity.

05_22.TXT: Table 22. P-wave logger (PWL) velocity.

05_23.TXT: Table 23. Velocity (PWS1 frame, Z-direction).

05_24.TXT: Table 24. Velocity (PWS3 frame, X-direction).

05_25.TXT: Table 25. Undrained shear strength (AVS).

05_26.TXT: Table 26. Undrained shear strength (penetrometer).

05_27.TXT: Table 27. Longitudinal (Z-direction) and transverse (Y-
direction) resistivity.



CONTENTS OF THE CD-ROM (continued)

174AX Initial Reports

174AXIR.PDF is the table of contents that is linked to individual files. 
Click on the chapter title to open that file. 174AXIR.PDF is located in 
the root directory.

The individual files for the Leg 174AX Initial Reports volume are in the 
174AX_IR directory of the CD-ROM.

PRELIM.PDF contains the title page, as well as other information from 
the front of the volume, including shipboard participants and member 
nations of the Ocean Drilling Program.

CHAP_01.PDF contains the single chapter file.



CONTENTS OF THE CD-ROM (continued)
174B Initial Reports

174BIR.PDF is the table of contents that is linked to individual files. 
Click on the chapter title to open that file. 174BIR.PDF is located in the 
root directory.

The individual files for the Leg 174B Initial Reports volume are in the 

174B_IR directory of the CD-ROM.

PRELIM.PDF contains the title page, as well as other information from 
the front of the volume, including shipboard participants and member 
nations of the Ocean Drilling Program.

The chapter files are listed by numerical order. Each file is named 
CHAP__##.PDF, where ## is the number of the chapter. The chapters 
can be reviewed as a group from 174BIR.PDF.

Also included on the CD-ROM are the following types of files:

Visual core-description (VCD) forms and digital core images in a 
PDF format. These files can be found in the 174B_IR\CORES 
directory.



An appendix to Chapter 3. This file is 174B_IR\APPENDIX.PDF.

Shore-based processed logs in a PDF format. This file is 
174B_IR\LOGGING.PDF.

An ASCII version of a table from Chapter 3 (Site 1074). This file is 
174B_IR\TABLES\03_03.TXT (Table 3. Multisensor track [MST] 
measurements for all APC cores from Hole 1074A).



List of Acrobat Catalogs
The following Acrobat catalogs, or indexes, are available on the CD-
ROM. They may be used individually, or in any combination. For more 
information see Acrobat Search in this document or Acrobat HELP.

The Initial Reports volumes are cataloged individually as follows:

174A_IR\INDEX.PDX

174AX_IR\INDEX.PDX

174B_IR\INDEX.PDX

For the Compiled Electronic Index of the Proceedings of the Ocean 
Drilling Program, NDX.PDX catalogs each individual volume for leg-
specific searches.

ODPINDEX\NDX.PDX



.PDF 
Compiled Electronic Index of the
Proceedings of the Ocean Drilling Program

The Compiled Electronic Index contains individual indexes of the 
Proceedings of the Ocean Drilling Program Volumes 101–160.

The indexes are presented in ODPINDEX and are named ###NDX

(### = the leg number). These indexes can be searched individually or 
collectively.

Volumes 101–131 were scanned using Adobe Capture and prepared as 
Adobe Acrobat PDF files. Although Capture is quite accurate as an 
optical character reader program, there is the possibility of introduced 
typographical errors in these documents. These files were not checked 
against the original volumes for original indexing or editorial errors, 
although occasional errors were corrected. 

Beginning with Volume 132, electronic files were available, so scanning 
was not required. 

Complete information about how to use the Search Engine is included 
with Acrobat Reader and Exchange under HELP.



Please forward corrections, questions, or comments to the Publications 
Department, Ocean Drilling Program, 1000 Discovery Drive, College 
Station, TX 77845-9547 or e-mail:

pub_production@odp.tamu.edu

mailto:pub_production@odp.tamu.edu


PRINT CITATIONS

Reference to the whole or to part of these volumes should be made as 
follows:

174A Initial Reports

Austin, J.A., Jr., Christie-Blick, N., Malone, M.J., et al., 1998. Proc. 
ODP, Init. Repts., 174A: College Station, TX (Ocean Drilling 

Program).

Shipboard Scientific Party, 1998. Site 1071. In Austin, J.A., Jr., 
Christie-Blick, N., Malone, M.J., et al., Proc. ODP, Init. Repts., 
174A: College Station, TX (Ocean Drilling Program), 37–97.

174AX Initial Reports

Miller, K.G., Sugarman, P.J., Browning, J.V., et al., 1998. Proc. 
ODP, Init. Repts., 174AX: College Station, TX (Ocean Drilling 
Program).

Miller, K.G. Sugarman, P.J., Browning, J.V., Olsson, R.K., Pekar, 
S.F., Reilly, T.J., Cramer, B.S., Aubry, M.-P., Lawrence, R.P., 



Curran, J., Stewart, M., Metzger, J.M., Uptegrove, J., Bukry, D., 
Burckle, L.H., Wright, J.D., Feigenson, M.D., Brenner, G.J., and 
Dalton, R.F., 1998. Bass River Site. In Miller, K.G., Sugarman, P.J., 
Browning, J.V., et al., Proc. ODP, Init. Repts., 174AX: College 
Station, TX (Ocean Drilling Program), 5–43.

174B Initial Reports

Becker, K., Malone, M.J., et al., 1998. Proc. ODP, Init. Repts., 
174B: College Station, TX (Ocean Drilling Program).

Shipboard Scientific Party, 1998. Site 1074. In Becker, K., Malone, 
M.J., et al., Proc. ODP, Init. Repts., 174B: College Station, TX 
(Ocean Drilling Program), 25–35.



ELECTRONIC CITATIONS

CD-ROM

Reference to the whole or to part of these volumes should be made as 
follows:

174A Initial Reports
Austin, J.A., Jr., Christie-Blick, N., Malone, M.J., et al., 1998. Proc. 
ODP, Init. Repts., 174A [CD-ROM]. Available from: Ocean Drilling 
Program, Texas A&M University, College Station, TX 77845-9547, 
U.S.A.

Shipboard Scientific Party, 1998. Site 1071. In Austin, J.A., Jr., 
Christie-Blick, N., Malone, M.J., et al., Proc. ODP, Init. Repts., 
174A, 37–97 [CD-ROM]. Available from: Ocean Drilling Program, 
Texas A&M University, College Station, TX 77845-9547, U.S.A.

174AX Initial Reports

Miller, K.G., Sugarman, P.J., Browning, J.V., et al., 1998. Proc. 
ODP, Init. Repts., 174AX [CD-ROM]. Available from: Ocean 



Drilling Program, Texas A&M University, College Station, TX 
77845-9547, U.S.A.

Miller, K.G. Sugarman, P.J., Browning, J.V., Olsson, R.K., Pekar, 
S.F., Reilly, T.J., Cramer, B.S., Aubry, M.-P., Lawrence, R.P., 
Curran, J., Stewart, M., Metzger, J.M., Uptegrove, J., Bukry, D., 
Burckle, L.H., Wright, J.D., Feigenson, M.D., Brenner, G.J., and 
Dalton, R.F., 1998. Bass River Site. In Miller, K.G., Sugarman, P.J., 

Browning, J.V., et al., Proc. ODP, Init. Repts., 174AX, 5–43 [CD-
ROM]. Available from: Ocean Drilling Program, Texas A&M 
University, College Station, TX 77845–9547, U.S.A.

174B Initial Reports

Becker, K., Malone, M.J., et al., 1998. Proc. ODP, Init. Repts., 174B 
[CD-ROM]. Available from: Ocean Drilling Program, Texas A&M 
University, College Station, TX 77845-9547, U.S.A.

Shipboard Scientific Party, 1998. Site 1074. In Becker, K., Malone, 
M.J., et al., Proc. ODP, Init. Repts., 174B, 25–35 [CD-ROM]. 
Available from: Ocean Drilling Program, Texas A&M University, 
College Station, TX 77845-9547, U.S.A.



World Wide Web

Reference to the whole or to part of these volumes should be made as 
follows:

174A Initial Reports

Austin, J.A., Jr., Christie-Blick, N., Malone, M.J., et al., 1998. Proc. 

ODP, Init. Repts., 174A [Online]. Available from World Wide Web: 
<http://www-odp.tamu.edu/publications/174A_IR/174ATOC.HTM>. 
[Cited YYYY-MM-DD]

Shipboard Scientific Party, 1998. Site 1071. In Austin, J.A., Jr., 
Christie-Blick, N., Malone, M.J., et al., Proc. ODP, Init. Repts., 
174A, 37–97 [Online]. Available from World Wide Web:
<http://www-odp.tamu.edu/publications/174A_IR/CHAPTERS/
CHAP_03.PDF>. [Cited YYYY-MM-DD].

174AX Initial Reports

Miller, K.G., Sugarman, P.J., Browning, J.V., et al., 1998. Proc. 
ODP, Init. Repts., 174AX [Online]. Available from World Wide 



Web: <http://www-odp.tamu.edu/publications/174AX_IR/
174AXTOC.HTM>. [Cited YYYY-MM-DD]

Miller, K.G. Sugarman, P.J., Browning, J.V., Olsson, R.K., Pekar, 
S.F., Reilly, T.J., Cramer, B.S., Aubry, M.-P., Lawrence, R.P., 
Curran, J., Stewart, M., Metzger, J.M., Uptegrove, J., Bukry, D., 
Burckle, L.H., Wright, J.D., Feigenson, M.D., Brenner, G.J., and 
Dalton, R.F., 1998. Bass River Site. In Miller, K.G., Sugarman, P.J., 
Browning, J.V., et al., Proc. ODP, Init. Repts., 174AX, 5–43 

[Online]. Available from World Wide Web: <http://www-
odp.tamu.edu/publications/174AX_IR/CHAP_01.PDF>. [Cited 
YYYY-MM-DD]

174B Initial Reports

Becker, K., Malone, M.J., et al., 1998. Proc. ODP, Init. Repts., 174B 
[Online]. Available from World Wide Web: <http://www-
odp.tamu.edu/publications/174B_IR/174BTOC.HTM>. [Cited 
YYYY-MM-DD]

Shipboard Scientific Party, 1998. Site 1074. In Becker, K., Malone, 
M.J., et al., Proc. ODP, Init. Repts., 174B, 25–35 [Online]. 
Available from World Wide Web: <http://www-odp.tamu.edu/



publications/174B_IR/CHAPTERS/CHAP_03.PDF>. [Cited 
YYYY-MM-DD].



ACROBAT OVERVIEW

How to view files, and why bookmarks and articles are 
useful

There are many ways to move through an Acrobat PDF file. Within the 
Acrobat program the ARROW BUTTONS move the user to PREVIOUS 

PAGE or NEXT PAGE. 

The FIRST PAGE and LAST PAGE buttons move the document to the 
first or last page of a document. 

The GO BACK and GO FORWARD buttons retrace your steps through 
a document.

At the present stage of Adobe’s software development, the quality of 
page and graphic images is affected significantly by the size and quality 
of the monitor on which the material is viewed. An optimized system, 
rather than the minimum required, is always recommended. In 
particular, fonts may appear to be distorted in small-scale images. 
Enlargement (zooming) improves image quality. High-resolution (600 
dpi or better) laser printers produce excellent printed images.



BOOKMARKS

The default for ODP files is to open with Bookmarks and page visible. 
To move to the page view specified by a bookmark, click the bookmark 
text (the pointer changes to a pointing finger) or double-click the page 
icon to the left of the bookmark name (the pointer changes to an arrow).

Click the triangle to the left of a bookmark to show or hide any 

subordinate bookmarks.

ARTICLES

Articles connect related parts of a document by creating a reading path 
through the document. Articles are usually created to make reading 
documents with multiple columns easier. You can use the View > 
Articles command to find out whether a document contains articles and 
to read articles. You can also use the hand tool to read articles. The 
pointer changes to the read article pointer when positioned over any part 
of the article, and Read Article appears in the status bar.

To read an article:

1. Choose one of two options:



Choose View > Articles, select the article you want, and click Read 
to display the first text block in the sequence.

Note: Clicking Info in the Articles dialog box displays the title, 
author, subject, and any keywords associated with the article. If you 
have a larger monitor and want to keep this dialog box displayed so 
you can go from one article to another, deselect Hide on View.

Select the hand tool and click any part of the article to start reading 
at that point in the article, or hold down Control (Windows) or 

Option (Macintosh) and click to start reading at the beginning of the 
article.

While you read an article, the pointer changes to the Follow Article 
pointer, and Follow Article appears in the status bar.

To return to the previous view of the article, hold down the Shift key and 

click. To return to the beginning of the article, hold down Control 
(Windows) or Option (Macintosh) and click.

2. Continue to click until you reach the end of the article. At the end 
ofthe article, the pointer changes to the End Article pointer and End 
Article appears in the status bar. Click again to return to the page view 
displayed before you started reading the article.



To exit an article at any time:

Select any navigation method other than pressing Enter or Return.

Go to another article or page.

Hold down Shift + Ctrl (Windows) or Shift + Option (Macintosh) 

and click.

Tips on fonts and printing

These files were created with fonts embedded.

The quality of page and graphic images is limited by the quality of the 
viewing screen and by the amount the screen image is enlarged. The 
files will reproduce on paper very well if they are printed on a high-
quality 600-dpi printer.

Not all printers are capable of printing close to the edge of the page. 
Sometimes it is necessary to activate the “Shrink to fit” command in the 
print control box to print a full image.



Acrobat Search 

The following information was prepared to familiarize the user with the 
Acrobat Search Engine capabilities. For complete information on using 
the Search Engine within the Acrobat program, refer to HELP/Searching 
indexed document collections.

The complete search engine was included on this CD for installation. 
For installation instructions, please see the ACROREAD.TXT file.
Search will allow searches that are based on proximity, word stem, 
sound-alikes, and a thesaurus choice. It can also be case sensitive. 
Search will search all Acrobat documents on the CD-ROM, whether 
open or closed, including figures.

Searching cataloged documents

With the Acrobat Exchange Search command, you can perform full-text 
searches of collections of PDF documents that have been cataloged with 
the Adobe Acrobat Catalog program.

Unlike the Find command of a word-processing program, which 
searches for words by reading every word on every page, the Search 



command searches full-text indexes created by Acrobat Catalog. A full-
text index is an alphabetized list of all the words and terms used in a 
collection of documents. These full-text indexes can represent hundreds 
or thousands of documents, and-compared with searching a document 
word by word one page at a time-searching a full-text index is very fast.

The Search command uses full-text indexes to find words and terms 
quickly in the documents without having to open the documents. The 
Search command lets you search thousands of documents in seconds. 

Using the Search command, you can quickly search indexed PDF 
documents for single words or terms, phrases, or arbitrary character 
patterns specified with wild-card characters. You can also search for 
documents that contain combinations of words and phrases. You can, for 
example, search for documents that contain the phrase status report and 
that contain some form of the word succeed, such as succeed, success, or 
successful.

To add an index to the search list

1. Select Search > Indexes from the Tools menu, or if the Acrobat 

Search window is already open, click the Indexes button. The Index 
Selection dialog box appears.
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2. Click Add. The Add Index dialog box appears.

3. Locate and select the index you want to use. Acrobat index definition 
filenames end with .PDX (see the “List of Acrobat Catalogs” section 
this readme file for available indexes).

4. Click OK (with Windows) or Open (on the Macintosh) to select the
index and close the Add Index dialog box. Alternatively, double-click
the name of the index you want to use. The new index is added to th

search list.

Note: If an index was installed previously (e.g., from another CD-ROM) 
it will appear dimmed in the search list because it is unavailable for 
searching.

Selecting indexes to search

The Search command searches for words and character sequences in 
documents that have been indexed by the Acrobat Catalog program. By 
selecting a single index, you can find words and terms in any document 
in the collection of indexed documents. By selecting two or more 
indexes, you can search for words in two or more collections at the same 
time.



To use an index, you must add it to the list of available indexes. As you 
search for information, you choose which indexes to search by selecting 
and deselecting indexes in the list of available indexes.

To help decide which index to use for your search, you might want to 
view a description of an index. For additional instructions, within the 
Acrobat program see HELP/Viewing information about indexes.
1. Click the Indexes button in the Acrobat Search window. Alternatively, 
choose Search > Indexes from the Tools menu. The Index Selection 
dialog box appears.

2. Click the check box to the left of the index you want to use.

3. Click OK to close the Index Selection dialog box and return to the 
Search window.

Note: Dimmed indexes are currently unavailable for searching.

Starting a search

1. Choose Search > Query from the Tools menu, or click the Search 
button on the toolbar.



 to 
 

2. Select one or more indexes. The indexes represent the document 
collections you want to search.

3. Choose one or more of the following options:

Enter a search term, phrase, or Boolean expression. You don’t have
enter search text; you can perform a search with just Document Info
field values or a document creation or modification date range.

Enter one or more Document Info field values, either to limit your 

search or to find documents with field values you specify.

Enter a creation or modification date range, either to limit your search or 
to find documents created or modified in the periods you specify.

Choose one or more search options.

4. Click Search to perform the search. Acrobat Exchange searches the 
index or indexes and displays a list of all the found documents in the 
Search Results window.

5. View the search results. By default, the documents returned from a 
search are listed according to a score (or relevance ranking), which 
places the documents most likely to contain relevant information at the 
top of the list. Double-click a document title to display the first page that 



contains a search term in that document. With one of the documents 
returned from the search displayed, you can use the Search Next and 
Search Previous buttons to see all the pages containing search terms in 
all the documents returned from the search.

See Viewing search results for more information.
After performing a search, you can use the Refine feature to perform 
another search that is limited to just those documents returned by the 
previous search.

FIND/Acrobat Reader

Users of Acrobat Reader who do not wish to use the SEARCH engine 
will be able to use the FIND option under TOOLS. FIND can search 
through open documents for specific words or phrases.

How to set up a Web browser 

FILE/PREFERENCES/WEBLINK/BROWSE



If you choose a web browser in your Acrobat PREFERENCES file, you 
can make an automatic link from the Acrobat files on the CD-ROM to 
the World Wide Web.

To set your preferences:

1. Choose FILE > Preferences > Weblink.

2. Choose from the following options:
Choose an option from the Link Information pop-up menu to 
determine whether Exchange displays a URL address at the bottom 
of the window when the pointer is over a Web link.

Select the Show Toolbar Button option to show the Web Browser 
button in the toolbar.

Select the Show Progress Dialog option to display a progress dialog 
box showing status, such as how much data is downloading after 
activating a Web link.

To select a different Web browser, click Browse (Windows) or Select 
(Macintosh) and choose the new browser from the Open dialog box.

If the selected browser has additional options, click Options to access 
those options.



3. Click OK to save your preferences.



WHERE TO GET MORE HELP

1. See the HELP files in the Acrobat program.

2. Visit Adobe’s homepage site on the World Wide Web:

http://www.adobe.com/

3. Contact ODP: Chief Production Editor, Ocean Drilling Program, 

Texas A&M University, College Station, TX 77845, U.S.A.

pub_production@odp.tamu.edu

http://www.adobe.com/
mailto:pub_production@odp.tamu.edu
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